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ALAN ADI SORU SAYISI SINAV SURESI (DAKIKA)

Atama Yapilacak Gorevin Niteligi 50 75

ADAYLARIN DIKKATINE!

. Sinav saat 10.00°'da baslayacaktir. Sinav basladiktan sonra ilk 30 dakika dolmadan disar ¢ikmayiniz.
. Sinav sirasinda soézlik, hesap cetveli veya makinesi, ¢cagri cihazi, cep telefonu, telsiz, radyo gibi elektronik

iletisim araglarini yaninizda bulundurmayiniz. Bu araglari kullanmaniz ve kopya ¢cekmeye tesebbls etmeniz
halinde sinaviniz gecersiz sayilacaktir.

. Bagvuru sartlarini tasimadiginiz halde sinava girmeniz, kopya ¢cekmeniz, bagka adayin sinav evrakini

kullanmaniz, gecerli kimlik belgenizi ve sinav giris belgenizi ibraz edemediginiz durumlarda sinaviniz
gecersiz sayilacaktir.

Sinavin degerlendiriimesi asamasinda, toplu kopya tespiti halinde sinaviniz gecersiz sayilacaktir.
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CEVAP KAGIDI VE SORU KITAPGCIGI iLE ILGILi ACIKLAMALAR

. Cevap kagidinizdaki bilgilerin dogrulugunu kontrol ediniz ve cevap kagidinizi mirekkepli kalemle imzalayiniz.
. Kitapgik tirtiniizi cevap kagidinizdaki ilgili alana kodlayiniz. Degerlendirme iglemleri cevap kagidindaki

kodlamalara goére yapildigindan, eksik ya da hatali kodlamalarda sorumluluk size ait olacaktir.

. Cevap kagidi tUzerinde kodlamalarinizi kursun kalemle yapiniz.
. Degistirmek istediginiz bir cevabl, yumusak silgiyle cevap kagidini érselemeden temizce siliniz ve yeni

cevabinizi kodlayiniz.

. Soru kitapg¢iginin sayfalarini kontrol ediniz, baski hatasi var ise degistiriimesini saglayiniz.
. Soru kitapg¢iginizin 6n yizindeki ilgili yerlere ad, soyad ve T.C. kimlik numaranizi yaziniz.
. Her sorunun bes segeneginden sadece biri dogrudur. Dogru segenegi, cevap kagidinizin ilgili sitununa,

soru numarasini dikkate alarak, yuvarlagin disina tasirmadan kodlayiniz. Soru kitap¢igi lizerinde yapilan
cevaplandirmalar dikkate alinmayacaktir.

8. Yanlis cevaplariniz dikkate alinmadan sadece dogru cevaplariniz lizerinden puanlama yapilacaktir.
9.

Sorulari ve sorulara verdiginiz cevaplari, yaninizda gétiirmek amaciyla kaydetmeyiniz; higbir sekilde disari
¢cikarmayiniz.

10. Sinav bitiminde, soru kitap¢igi ve cevap kagidini salon gorevlilerine teslim ediniz.

BASLAYINIZ DENILMEDEN SORU KIiTAPCIGINI ACMAYINIZ.




MUHENDIS (BILGISAYAR) B

. Birden fazla igin bir donanimi kisa siirelerle
paylagsmasini saglayan sistemlere ne ad verilir?

A) Main Frame

B) Toplu islem

C) Dagitik sistemler

D) Gémulu sistemler

E) Zaman paylasimli sistemler

. Asagidakilerden hangisi “Temel igletim Siste-
mi Katmanlan” iginde yer almaz?

A) Yazihim katmani

B) Uygulama katmani

C) Kabuk (Shell) katmani
D) Cekirdek katmani

E) Donanim katmani

. Asagidaki ifadelerden hangisi yanhistir?

A) isletim sistemleri sistem kaynaklarini verimli
bir sekilde kullanabilirken, kullanicilara da
kolay bir araylz sunmalidir.

B) Kabuk katmani uygulama programlarina hiz-
met eden bir katmandir.

C) Arabirimler, surlculerin karmasik denetim
ayrintilarini sistem programlarindan saklar.
D) Salt okuma amaciyla ulagilan ortak kaynaklar

icin zaman uyumu gerekmez.

E) Sorgulama amaclh da olsa ortak kaynaga
erisim denetim altinda olmalidir.

. Her algoritmada asagidaki kriterlerlerden han-
gisi olmamalidir?

A) Sonluluk
C) Gizlilik

B) Aciklik
D) Etkinlik
E) Cikti

. Asagidaki algoritmalardan hangisi insanlarin
oyun kartlarini siralamasina en ¢ok benzer?

A) insertion sort
C) Selection sort
E) Quicksort

B) Bubble sort
D) Shell sort

6.

10.

“5,1, 8, 3, 4” seklinde verilen sayi dizisini
Bubble Sort siralama algoritmasi ile kiigiikten
buyuge siralamak igin gerekli yer degisim
sayisli kagtir?

A) 10
C)7

B)9
D)5
E) 4

Bol ve fethet (Divide-and-conquer) yontemi
asagidakilerden hangisinin kullanimini igaret
eder?

A) Etkilesim B) Baskin ifade
C) Dallanma D) Aritmetik operator
E) Ozyineleme

Ozyinelemeli bir yéntem asagidakilerden han-
gisi ile en iyi sekilde tanimlanir?

A) Kendini asla ¢cagirmaz.

B) “While to” déngusu kullanir.

C) Kendini sadece bir defa ¢agirir.

D) Belirli durumlar altinda kendini ¢agirir.

E) Kosturuldugunda her zaman kendini ¢agirir.

Metod override (ezilme) nedir?

A) Ust siniftan alinan bir 6zelligi alt sinifta degis-
tirmektir.

B) Nesne erigimlerini kisitlayip dolayli erisim
verme yoludur.

C) Referans alanin korunmasidir.

D) Ayni isimli metodlarin tekrar kullaniimasidir.

E) Bir nesnenin birden ¢ok boyuta girebilmesidir.

Yapisal Programlama dilinde “destructor” igin
asagidaki verilen tanimlardan hangisi yanhstir?

A) Bir destructor, nesnenin ait oldugu scope igin-
deki galismasi bittiginde otomatik olarak galigir.

B) Destructor ile constructor birbirinin tersidir.

C) Bir class igin destructor tanimlanmasa bile
compiler otomatik olarak olusturur.

D) Bir class destructori nesnenin kullanimi bitti-
ginde dolayli olarak ¢agirilir.

E) Destructor, parametre alir ve deger dondurr.
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Asagidaki kullanilan matematiksel fonsiyonlar-
dan hangisinin iglevi dogru ifade edilmistir?

A) sqgrt (x) x Uzeri y;

B) pow(x,y) X’in karekoku

C) fabs(x) x’in mutlak degeri

D) ceil (x) X'i alt tamsayiya yuvarlar
E) floor(x) Xx’i Ust tamsayiya yuvarlar

j=i++ ifadesinde i’nin baslangi¢ degeri 5 ise,
j ve i’'nin sonraki degerleri nedir?

6
6)

= =5 B) j:5,
= =6 D) J=5
E) j=10, i=6

6
5

A)j
C)j

Asagidaki degisken tanimlamalarindan hangi-
si dogrudur?

A) int final#notu; B) int final notu;
C) int FINAL-NOTU; D) int 1finalnotu;
E) int finalNotu;

1’den 10’a kadar olan tek sayilarin toplamini
gosteren déngi asagidakilerden hangisidir?

A) int toplam = 0; for (int i=1; i<=10; i+=2) toplam += i
B) int toplam = O; for (int i=0; i<=10; i+=2) toplam +=

C) int toplam = 0; for (int i=2; i<=10; i+=2) toplam += i
D) int toplam = 0; for (int i=0; i<=10; i+=2) toplam *=i;
E) int toplam = O; for (int i=1; i<=10; i+=2) toplam *=i;

Bir case ifadesinde blok igerisinden ¢ikilmasini
saglayan komut asagidakilerden hangisidir?

A) Return
C) Continue
E) Else

B) Void
D) Break

16.

17.

18.

19.

20.

do-while déngiisii hangi durumlarda kullanilir?

A) Bir ya da daha fazla sayida deyimin belli bir
kosulun gergeklesmesine dek tekrarlanmasi
s6z konusu ise kullanilir.

B) Bir dongliniin ¢alismasinin, bir kosula bagh
oldugu durumlarda kullanilr.

C) Déngi sonunda denetlenmesinin gerektigi
durumlarda kullanilr.

D) Eger bir degiskenin degeri belirli sabitlerle
karsilastirilacak ve bunun sonucunda farkli
islemler yapilacak ise kullanilir.

E) Karsilastirma islemi sonucunda bir eylemin
yapilmasi s6z konusu ise kullanilir.

Bir sinifin miras alinmasi istenmiyorsa hangi
komut kullaniimahdir?

A) Static
C) Abstract
E) Private

B) Final
D) Super

Alt sinifta olusturulan yeni bir metot, temel si-
nifta tanimlanmis olan hangi liyeye erisemez?

A) Public
C) Protected
E) Private

B) Tanimsiz
D) Static

Asagidakilerden hangisi verilen kod pargasi-
nin kosma zamanini tanimlar?

for(int i=0; i<10; i++)
for(int j=0; j<N; j++)
for(int k=N-2; k<N+2; k++)
cout <<ij<<““<<j<<endl;

A) O(log n)
C) O(n)

B) O(n log n)
D) O(n?)
E) O(n?)

n elemanl bir diziye birlegtirme siralamasi
(merge sort) islemi uygulandiginda olasi en_
koétiu siralama performansi agagidakilerden
hangisi ile tanimlanabilir?

A) O(1)
C) O(n)

B) O(log n)
D) O(n log n)
E) O(n?)



22,

23.

24,

MUHENDIS (BILGISAYAR) B
21. Veritabaninda DROP TABLE komutu ne ise yarar?

A) Belirlenen bir tablo igin (index) yaratiimasini
saglar.

B) Belirtilen tablonun ve dizinlerin veri tabanindan
silinmesini saglar.

C) Yeni bir tablonun, alanlarinin ve indekslerinin
yaratiimasini saglar.

D) Tabloya yeni alanlarin ilavesini veya alan
tanimlarinin degistiriimesini saglar.

E) Tablo tanimlanmasini ve bir diger tablo ile iligki
kurulmasini saglar.

PERSONEL tablosundan ADI Ahmet ve YASI
19 olan kisileri sql ciimlecigi ile dogru olarak
gosteren segenek asagidakilerden hangisidir?

A) SELECT ADI, SOYADI, ADRESI FROM
PERSONEL WHERE YASI =19 AND ADI =
‘Ahmet’;

B) SELECT ADI, SOYADI, ADRESiI FROM
PERSONEL BETWEEN YASI = 19 AND ADI
= ‘Ahmet’;

C) SELECT ADI, SOYADI, ADRESI IN PERSO-
NEL WHERE YASI = 19 AND ADI = ‘Ahmet’;

D) SELECT ADI, SOYADI, ADRESI FROM PER-
SONEL LIKE YASI = 19 AND ADI = ‘Ahmet’;

E) SELECT ADI, SOYADI, ADRESiI FROM
PERSONEL GROUP BY YASI = 19 AND ADI
= ‘Ahmet’;

Asagidakilerden hangisi sql fonksiyonlarin-
dan degildir?

A)AVG
C) LIKE

B) COUNT
D) SUM
E) MAX

Asagidakilerden hangisi, bilgisayar aglarinda
cakigma algilama protokoludiir?

A) CSMA/CD
C)LLC

B) MAC
D) IP
E) DHCP

25.

26.

27.

28.

29.

Asagidakilerden hangisi 10Base2 ag uygula-
masi i¢in yanhs bir tanimlamadir?

A) En fazla 4 repeater kullanilabilir.

B) 1 segment en fazla 185 m’dir.

C) Ortak yol (bus-tasit) topolojisine dayanir.

D) Band geniglig 10 Mbps’dir.

E) Band genigligi 100Mbps’dir. 1 segment en
fazla 185 m'dir.

Repeater’lar OSI referans modelinde hangi
katmanda caligir?

A) Uygulama
C) Oturum

B) Fiziksel
D)A§
E) iletim

Bir ag uizerinden diger ag lizerine gegecek
bilgi trafigini kontrol etmek ve onu yonlendir-
me gorevi asagidakilerden hangisi tarafindan
gerceklestirilir?

A) Hub yonlendirici

B) Repeater (tekrarlayici)
C) Bridge (kopri)

D) Gateway (gegit yollari)
E) Ethernet karti

212.175.186 agini 212.175.187 ip adresli

aga baglanmasi ve bu iki agda ortak makine
tanimlanmasi istenirse hangi cihazin kullanil-
masi gerekir?

A) Hub
C) Bridge
E) Repeater

B) Switch
D) Router

Ag lizerinde gonderilen bir veri paketinin ag-
daki tiim cihazlar tarafindan alinmasini sagla-
yan adres tipi hangisidir?

A) MAC adresi B) Multicast adresi
C) Baseband adresi D) VPN adresleri
E) Broadcast adresi
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Asagidaki komutlardan hangisi internette ara-
nilan bir adres ile baglantinin saglanip saglan-
madigini kontrol eder?

A) Trace
C) Help

B) Ipconfig
D) Ping
E) Rooting

Hexadecimal karsiligi Hex=(00,00,00) olan
renk asagidakilerden hangisidir?

A) Beyaz
C) Yesil

B) Siyah
D) Kirmizi
E) Mavi

Web tasariminda site yoneticisinin ziyaretgiler
hakkinda ayrintilara ve onlarin yorumlarina
ulagmasi ne ile saglanir?

A) Sitede verilen e-mail adresiyle
B) Siteye eklenen sayag ile

C) Formlar aracihgiyle

D) Sitenin database'i ile

E) Tablolar ile

Bir web sayfasina gezinti gubugu nasil eklenir?

A) Insert>Form

B) Insert>Component

C) Convert > Browser

D) Insert>Navigation Bar

E) Format>Dynamic HTML Effects

Asagidaki uygulamalardan hangisi bir web
sayfasinda gezerken ayni béliimlerin yeniden
yuklenmesini 6nler?

A) Frame kullanmak  B) Tablo kullanmak
C) Layer kullanmak D) Form kullanmak
E) Veri tabani kullanmak

35.

36.

37.

38.

Asagidakilerden hangisi bir web sayfasi ha-
zirlarken, ayni sayfa iginde her hangi bir yere
link vermeye yarar?

A) Java script
C) Mailto

B) Php
D) Goto
E) Anchor

Asagidakilerden hangisi yazillm yagsam don-
glisii siire¢ modellerinden spiral modelini en
dogru sekilde tanimlar?

A) Her adimda riskleri degerlendirir ve en kritik
eylemi en 6nce gerceklestirir.

B) Baslangicta sinirl bir isterler belirtimi olustur
ve kodlar. ihtiyag dogrultusunda isterleri ve
kodlari gelistirmeye devam eder.

C) Baslangigta her bir agsama igin isterler belirtimi
olustur ve sirasiyla bu agsamalar igin tasarim
ve kodlama gergeklestirir.

D) Sirasiyla isterler, tasarim, kodlama ve sinama
asamalarini gergeklestirir.

E) Bir miktar kod yazdiktan sonra kod hatalarini
ayiklar ve ayni iglemi tekrarlar.

l. Hizmetlere iligkin kisitlar veya zaman ki-
sitlar gibi sistem tarafindan sunulan iglev
tanimlan

Il. Ozel durumlarda sistemin nasil davranaca-
gina dair tanimlar

lll. Gelistirme siirecine ait standart ve kisitlar
IV. Belirli giris kosullarinda sistemin ne tiir bir
tepki verecegine dair tanimlamalar

isterler goziimlemesinde yukaridaki ifadelerden
hangileri iglevsel isterler baghgi altinda yer alir?

A)ll ve IV
C)lvelll

B) II, Il ve IV
D) I, llve IV
E) lll ve IV

Asagidaki standartlardan hangisi yazilim
isterler tanimlamalarina iligkin igerik ve
karakteristiklerin tavsiye edildigi bir Elekrik
ve Elektronik Miihendisleri Enstitlisii (IEEE)
standartidir?

A) |IEEE Std 829-2008
B) IEEE Std 830-1998
C) IEEE Std 982.1-2005
D) IEEE Std 730-2002
E) IEEE Std 828-2005
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Yazilim gelistirme surecinde agsagidaki model-
lerden hangisinin kullaniminda ortaya ¢ikan
hatalarin diizeltme maliyeti en yuksektir?

A) Spiral

B) Prototip

C) Kodla ve onar

D) Selale yontemi

E) RAD (Hizh Uygulama Gelistirme)

Yazihim gelistirme siirecinde ortaya ¢ikan
hatalar yaygin olarak hangi agamada yapilan
hatalardan olugmaktadir?

A) Uygulama B) Sinama
C) Kodlama D) Tasarim
E) Cozimleme

(1+i).(1-i) isleminin sonucu asagidakilerden
hangisidir?

A) 1+
C)2

ou
5

E) 2i

2(cos£+ i sinﬂ) sayisinin en sade yazilisi

asagidakilerden hangisidir?

A)1-43i
C) V3i

B)1+v3i
D) —V3i
E) 1

2(4-5 i)+9(3+2 i)-5(1-2 i) igleminin sonucu asagi-
dakilerden hangisidir?

A) 30+18 |
C)18i

B) 30-18 i
D) -30+18 i
E)-30-18

44. A=

45.

46.

47.

1 3 4
0—2 5] olduguna gore | A| asagidakiler-
0 0-3

den hangisidir?

A)2 B) 3
C)4 D)5
E)6
X—6y+2z=5
2x—-3y+z=4

3x+4y—z=-2

denklem sisteminin ¢6ziimii agagidakilerden
hangisidir?

X 2 X —17
A)x=|y|=| 3 B) x=|y|=|-2
X -1 X 4]
X 1] X —4
C)x=|y|=[-3 D) x=|y[=| 1
X —7] X 7

X 1

E)x=|y|=|-3

X -1

Paralel programlamada, Amdahl Yasasi’'na
gore eger F ardigik bir iglemin bir pargasiysa
ve (1-F) paralellestirilebilir kisimsa, N iglemci

kullanarak azami hizlanma +oIarak
F+1F

N
tanimlanmaktadir. Buna gore, sonsuz sayida
islemci i¢in programin % 5’i ardisik ve kalan
kisim parallellestirilebilir ise islemde ka¢ kat
hizlanma elde edilir?

A) 2
C) 10

B)5
D) 20
E) Sonsuz

4AB2xh ve 5BA3xh sayilarini karsilikh X-OR
islemine tabi tutan bir sistemin ¢iktisi ne olur?

A) 0000xh
C) FFFFxh
E) 11FFxh

B) 1111xh
D) 00FFxh
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48. 32 diigiime sahip bir ikili agacin (binary tree)
yuksekligi nedir?

A)4 B)5
C)8 D) 16
E) 32

49. Bir kiigiik bilgisayar sistemi arayiizii (SCSI)
veri yoluna en fazla kag adet cihaz baglanabilir?

A) 2 B) 4
C)8 D) 16
E) 32

50. Bellek adres islemlerinde asagidaki mantik
devrelerinden hangisi kullanilir?

A) Dogrudan bellek erisim devresi
B) 3 durumlu mantik devresi

C) Tam toplayici devre

D) Kod ¢6zlict devre

E) Coklayici devre

TEST BITTi.
CEVAPLARINIZI KONTROL EDINiz.




SINAV SURESINCE UYULACAK KURALLAR

1. Adaylar, sinav kurallarina ve salon goérevlilerinin tiim uyarilarina uymak zorundadirlar. Kurallara
ve uyarilara uymayan adaylarin sinavlari gegersiz sayilacaktir.

2. Sinav basladiktan sonra adaylarin salon goérevlileri ve birbirleri ile konusmalari, kalem, silgi vb. seyleri
istemeleri yasaktir.

3. Adaylar sinav suresince, sinav giris belgesi ile birlikte kimlik belgelerinden birini (nlfus clizdani,
pasaport veya surlcu belgesini) masalarinin tizerinde bulundurmak zorundadirlar.

4. Sinav evraklarini teslim etmeyen, soru kitap¢iklarinin sayfalarindan bir kismini eksik teslim
edenlerin sinavlari gegersiz sayilacaktir.

SALON GOREVLILERINCE SINAV BASLAMADAN ONCE ADAYLARA YAPILACAK SON UYARI

e Soracaginiz bir sey var mi? Varsa, simdi sorunuz.
e Sinav basladiktan sonra sorulariniza cevap verilmeyecektir.
e Baslama zilini bekleyiniz.
e Hepinize basarilar dileriz.
(Salon baskani baglama ve bitis saatini tahtaya yazacaktir.)

Bu kitap¢igin her hakki sakhidir. Hangi amagla olursa olsun, kitap¢igin tamaminin veya bir kisminin
Milli Egitim Bakanligi Olgme, Degerlendirme ve Sinav Hizmetleri Genel Miidiirliigiiniin yazil izni
olmadan kopya edilmesi, fotograflarinin ¢ekilmesi, bilgisayar ortamina alinmasi, herhangi bir yolla
c¢ogaltilmasi, yayimlanmasi veya baska bir amagla kullanilmasi yasaktir. Bu yasaga uymayanlar,
dogabilecek cezai sorumlulugu ve kitap¢igin hazirlanmasindaki mali kiilfeti pesinen kabullenmis
sayilir.
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